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1 PRINCIPLE 

This data collection tool offers the possibility to enter in an Excel form, before any intervention on site, 
the information required to install and configure an iPBX.  It does not allow the addition of subscribers 
in an existing configuration. 

The proposed solution can be used to create a standalone iPBX, and an iPBX integrated into a multi-
site configuration, managed or not managed by the MiVoice 5000 Manager application. 

For an iPBX integrated into a multi-site configuration, create a form per site.  

The general principle is described in the diagram below:  

  

1.1 SOFTWARE COMPATIBILITIES 

MiVoice 5000 Provisioning is compatible with: 

• MiVoice 5000 as of R5.3 

• MiVoice 5000 Manager as of release R2.3 

• Windows XP, Windows 7/8/10/16. 
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2 EXCEL PRE-REQUISITES 

2.1 SOFTWARE RELEASE 

To use the form, the minimum compatible release is Excel 2007 32 bits. 

2.2 INSTALLING VISUAL BASIC FOR APPLICATION 

The component Visual Basic for applications must be installed on the PC on which the form is used.  

For that, check the control panel to verify that Visual Basic for Applications is part of Microsoft Office 
(2007, 2010 or 2016) components. 

If this is not the case, install it from the installation support of Office 2007, 2010 or 2016. 

2.3 INSTALLING THE CERTIFICATE AND MACRO SIGNATURE 

The form contains some macros signed digitally via an Mitel_DC (Mitel Data Collecting) certificate. To 
be able to use the form, it is necessary to configure Excel to accept files containing signed macros. 

• Open Excel (without opening the form).  

• Click on File and follow this path: 

Options > Confidentiality management centre> Confidentiality management centre settings > 

Macro settings. 

• Select the option Disable all macros except digitally signed macros. Click OK. 

• Open the form: a warning on the deactivation of macros is displayed on top of the page (below the 
menu and tools bars). Proceed as follows: 

1. Display the information by clicking the Options... button associated with the security warning.  

2. Then click the hypertext Display signature details. 

3. Click Display certificate. 

4. Click Install certificate.  

5. Windows 8: select the storage location (current user or local computer) 

6. Follow the installation wizard by selecting Place all certificates in the following store > Trusted 

root certification authorities. 

7. At the end of the installation, in the Security Alert - Macros & ActiveX dialogue box, select the 

option Always trust macros from this publisher. 

The macros will then be activated by default for all the collected forms. 
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3 DESCRIPTION OF THE FORM  

When the Excel file is opened, a Welcome page appears (it is advisable to use a 1280 x 1024 screen 
resolution for user comfort).  

The forms necessary for the collection are grouped by categories.  Each category is described in detail 
in the paragraphs below.  

To fill out the form, it is advisable to proceed as follows: 

1. Define the system type on the Welcome page (see Section 3.1). Depending on the type of 

system, some links may appear or disappear; for instance: the link to the Installation (CTRL I) 

tab is not displayed if MiVoice 5000 Server box is ticked, but appears if the Mitel X Series 

Gateway box is ticked.  

2. Then click the links available in the different categories. If some links are disabled, it is possible to 
reactivate them redisplaying the corresponding hidden tab. 

3. After duly filling the tab, return to the welcome page by clicking  then tick the corresponding 
line to indicate that the tab has been completely filled in, but above all so the data entered will be 
taken into account in the collection.   

 
CAUTION: A filled in tab will not be taken into account in the collection if the corresponding 

box is not ticked. 

At the bottom of the page an Uncheck all boxes button allows you, while using an already filled in 

form, to remove the ticks that have been inserted and restore the default values of the System type 
column. Since the data in the different cells are kept, they will be modified or retained as the case may 
be.  

Information on how to use the Generate iPBX / MiVoice 5000 Manager data button is given in 
Section 3.7. 

All the yellow cells of a line must be filled out, either as free text or options. Shaded cells are calculated 
or inherited from another tab. 

Each cell is accompanied by a tooltip with some checks on the digital type and options cells, but there 
is no check on cells that accept texts (especially accented characters or ASCII 7). 

Some macros format the content of certain cells to make them compliant with the iPBX formats 
(example, Feature classes). 

 
CAUTION: Incremental data input in the Excel file does not respect the authorised input 

length in a cell. 

3.1 SYSTEM TYPE 

MiVoice 5000 provisioning does not allow the configuration of a cluster. 

It is important to define the type of system because it may vary according to the data to be collected. 

• Select the configuration type: 

o Standalone site or first site of a multi-site configuration: The directory parameters and 

external records are collected. 

• Select the cabinet type: 
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o Mitel 5000 Gateways or MiVoice 5000 Server gateway: selecting MiVoice 5000 Server 

hides the installation link. 

• Specify the type of messaging system: 

o IVB: if IVB is ticked, the UCP and secondary UCP messaging links are hidden, and the 

IVB classes link displayed. 

• Select the TWP release installed on the system: 

o TWP 3.X or TWP 4.X : if either of the releases is ticked, the link to the TWP records is 

displayed but the content of the tab differs. 

• Select AMC if applicable: 

o if AMC is ticked, the link Technical characteristics of AMC subscribers is displayed. 

Once the system type is defined, go to the other parameters using the previously described procedure. 

3.2 GENERAL PARAMETERS 

3.2.1 CUSTOMER DATA 

This tab is used to save purely information data for the installer and are not exported: customer details 
and order characteristics.  

3.2.2 RESOURCES 

This tab is used to compare the capacities purchased by the customer and those declared in the 
configuration.  

The cells with a yellow background must be filled in: 

• Licences / Hardware: in the Purchased column, enter the value that corresponds to the order.  

• Range of numbers: indicates the lower and upper limit of the internal number range (even if it is 

divided into several ranges). These two limits are then automatically duplicated in the Installation 
tab. 

• Terminals: three types of information must be entered here. 

o In the Terminals label a first cell is used to freely enter the different types of terminals 

used on the installation (for example:  6757i); the information entered will then be 

processed in the Allocation tab and via the Calculate function of the Resources tab. 

Bullet list (level 2) 

o This input is associated with the type of licence proposed in the options that appear 

when the next cell is selected. 

o In column Client Licenses Blustar select YES if it is a terminal Blustar Client (audio or 

video), NO otherwise, 

o For each terminal type, enter the quantity purchased.  

After entering the Assignments Management (Subscribers Management) tab, the Used column is 

automatically updated and erroneous values appear in red. A symbol  is displayed as errors 
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contained in the page. The calculation of the adequacy of the number of licenses purchased and the 

needs of the configuration is also done by the Enter key to confirm the correction of a cell of the 

Purchased column or by clicking on Calculate.  

Line with decline missing Licenses displays the number of missing licenses considering the rules 
fallback licenses (see Operating Manual AMT/PTD/PBX/080 *). 

3.2.3 GENERAL DATA/IP CHARACTERISTICS OF THE INSTALLATION 

These tabs do not result in data generation. They enable the installer to group together some previous 
configurations and the IP parameters of the configuration to be installed. 

3.2.4 HELP 

The Help tab is accessible from each of the tabs (another link on the welcome page is represented by 
the question mark on the top right hand corner). It exists in form of a pdf file and requires the presence 
of Adobe Reader on the PC on which the form is located. 

To open the pdf file, double-click the pdf picture.   

This tab also contains a Version button (on the top right hand corner) which displays an About window 
that indicates the version of the form. 

3.3 INSTALLATION PARAMETERS 

3.3.1 INSTALLATION (CTRL I) 

These installation parameters are meant for Mitel X Series Gateway installation. For a MiVoice 5000 
Server, the installation procedure must result in the same operation status. 

Installation name and number: The name entered is transferred to the Web Admin welcome page.It 
must be limited to 24 characters; accented characters and special characters are not allowed. It is also 
used to create the configuration .zip file name (example 002.Mitel.DataCollecting.zip). The installation 
number is the 10-digit IID number. 

Site number: this number also enables the installer to identify the location of the site in a 
multi-site configuration. It is also used to create the configuration .zip file name (example 

002.Mitel.DataCollecting.zip). 

Key code: enter the key code. 

Do not fill in the following two parameters for the collection: 

Automatic creation of subscribers: leave it on 0. No subscriber should be defined on the iPBX when 
form data import is started (except the default subscribers: common subscriber, HSCX modem 
subscriber, etc.).  

Automatic creation of Integrated Voice Mail: leave it on 0. The IVB number must be created 
manually after CTRL I.  

First number of the local range/ Last number of the local range: These values are entered in the 
Resources tab. 

Number of the Common subscriber: created by default because it is obligatory in the installation. 



MIVOICE 5000 PROVISIONING DATA COLLECTING TOOL 

AMT/PTD/NMA/0058/7/0/EN 06/2019 7 

Subscribers' password: enter 0000 by default; may be modified (4 digits); it will be assigned to 
subscribers whose technical record user password has not been entered.  

The other parameters must be entered according to the configuration. 

3.4 TELEPHONE PARAMETERS 

3.4.1 FEATURE CLASSES / PSTN CATEGOIES / TL CLASSES 

The information entered in the Feature classes, PSTN categories and TL classes columns is 
formatted by the macro in upper case and are truncated according to the number of characters 

expected by the iPBX.  The other columns display some options.  The Signature type column 
(Feature class) must also be filled in, if necessary, using the options menu.  

When a class/category is added, all the cells of the line must be filled out. It is added to the options 
proposed in other tabs (example: Technical record). 

 
CAUTION: it is necessary to declare regional directions on the iPBX (menu: Telephony 

service > Numbering plan > Direction names) before import if they must be used 

in the PSTN tab.  It is also necessary to declare private directions on the iPBX 

(menu: Telephony service > Numbering plan > Direction name) with access to 

the different areas B to H (menu: Telephony service > Numbering plan > User 

numbering plan > Access to directions) before import if they must be used in the 

TL tab. 

The information in red (line 1) is obligatory and should not be modified. 

3.4.2 TECHNICAL COMPANIES/DEPARTMENTS 

The information in red (line 1) is obligatory and should not be modified. 

3.4.3 IVB CLASSES 

This line appears on the welcome page if the IVB box has been ticked in System type. In the tab, the 
values must be within the range indicated by the tooltip. 

3.4.4 CHOICE ON LIST DIRECTORY  

This line appears for a standalone site or for the first site of a multi-site network. 

1. In the Gender, Function and Forbidden numbers list column enter the values which must 
appear in the directory and in options in other tabs.  

2. After entering the list of forbidden numbers, click Update of Genders/Functions/Forbidden 

numbers list. This action:  

o Lets you use the values of forbidden numbers in the options of the Forbidden numbers 

list column located after all the Hierarchy columns 

o Lets you sort these columns in alphabetical order. 

 
Note: If this phase is skipped, any change of tab triggers the update. 

3. Do not modify the values in red STE0 and SERV0 in the level 1 and level 2 hierarchies: these are 
default values expected by the iPBX. 
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4. Other hierarchies may be entered: they will be sent to options in the Hierarchy column of directory 
records. 

 

 
CAUTION: For a multi-site configuration, the information in the Directory, Directory 

customization and External directory records fields are not exported to the first 

site on the multi-site network. However, for the other sites, this information must 

be retained because it enhances the options of other tabs (see Section 3.8). 

3.4.5 DIRECTORY CUSTOMIZATION 

This line appears for a standalone site or for the first site of a multi-site network. 

Directory customisation allows the creation of additional attributes in the internal or external directory. 
Up to 10 attributes may be added and will be transferred to the last columns of these records. 

3.4.6 EXTERNAL DIRECTORY RECORDS 

This line appears for a standalone site or for the first site of a multi-site network. 

Hierarchy column: if the record contains an abbreviated number and the hierarchy is different from All 

hierarchies, click Hierarchy Selection then select any of the hierarchies (previously defined in the 

Choice on list Directory tab) in order to define the number's visibility to internal subscribers.  

Any attributes created in the Directory customization tab is located there.  

3.4.7 PARAMETERS TWP UCP  

The informations entered in these two tables are used to fill out the TWP and UCP messaging list 
choices. 

3.5 MULTISITE PARAMETERS (OTHERS...) 

3.5.1 GIC/ INTERNAL PLANS / EXTERNAL NUMBER SEGMENTS 

GIC: enter the intercom group names. 

Internal plans: do not modify the parameter in red (plan 1 is obligatory).  

External numbering ranges: fill out all the fields. 

3.6 SUBSCRIBER MANAGEMENT 

3.6.1 INTERNAL DIRECTORY RECORDS 

Previous number: number of a previous installation if applicable 

Directory number: new directory number 

Location: geographic location 

Secretary: assistant number  
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Abbreviated number: concerns the subscriber 

Any attributes created in the Directory customization tab is located there.  

The subscribers defined in this tab are transferred to the Technical characteristics of subscribers, 
Allocations, UCP Voice mail, TWP records, Programmed keys and Forwards tabs. 

3.6.2 ALIAS DIRECTORY RECORDS 

Define the persons who will be attached to a main subscriber number. Any attributes created in the 

Directory customization tab is located there.  

3.6.3 TECHNICAL CHARACTERISTICS OF SUBSCRIBERS 

Do not modify the Previoux number, Name, Firstname and Directory number columns which come 
from the internal directory record.   

The Secondary directory number cell should not be left empty because it defines whether or not the 
subscriber is a multi-line subscriber. 

User password: for assigning to a subscriber a password other than the default password (installation 
tab). If the subscriber is a multi-line subscriber, there is only one subscriber password. 

3.6.4 ALLOCATIONS 

Do not modify the Previoius number, Name, Firstname and Directory number columns which come 
from the internal directory record.  

Equipment number: respect the 5-digit format: 

• 1st digit: cabinet number 

• 2nd and 3rd digit: card number 

• 4th and 5th digit: trunk number 

Telephone set model: the terminals proposed correspond to those defined in the Resources tab 
(terminal column). 

3.6.5 UCP VOICE MAIL 

This line does not appears on the welcome page if the IVB option has been ticked. 

Do not modify the Name, Firstname and Phone number columns which come from the internal 
directory record.   

The options proposed in the Feature group, Company and IMAP server column cells stem from the 

inputs made in the Parameters TWP UCP. 

The Destination column is filled in via the internal record E-mail field.  

Some options will be checked by MiVoice 5000 Manager during import. 
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3.6.6 TECHNICAL CHARACTERISTICS OF AMC SUBSCRIBERS 

Prefix Sip Number: this parameter is entered once and is used to configure SIP numbers in AMC. 

AMC User: select YES in the options to create a recording in AMC.  

Do not modify the PBX User and PBX Number columns whose values are taken from the internal 
directory record. 

SIP Number: unique number, different from the subscriber's number in the iPBX. 

SIP User Pw: password which must be used during the recording.  

Activate User / Use DMC (Direct Media Connect) / Call Waiting / Active MWI / Active DND: select 

on or off to activate the function in AMC. 

GSM Num 1 / Update of the mobiles: the Update of the mobiles button is used to establish 

correspondence with the content of the additional attribute created in the Internal directory record 

(via Directory customization). This content will be automatically transferred to the GSM Num 1 
column for each AMC user.  

 
CAUTION: the format for the GSM numbers must respect the E164 type. 

3.6.7 TWP RECORDS 

Do not modify the Name, Firstname, Phone number and Email columns which come from the 
internal directory record.  

Name of TWP Server: select an option (from the TWP UCP parameters tab). If you do not wish to 
configure any TWP records for a subscriber, leave the cell empty.  

Company / Domain: values from the TWP UCP parameters tab. 

Username: mandatory field. 

Some options will be checked by MiVoice 5000 Manager during import. 

3.6.8 PROGRAMMED KEYS 

Do not modify the Name, Firstname and Number columns which come from the internal directory 
record, just like the terminal model.   

20 programmed keys can be entered. 

 
CAUTION: To enter the different keys, move from left to right without leaving any blank 

space between the key numbers to be edited. A key number not entered is 

interpreted as end of input for the line. 

3.6.9 FORWARDS 

Do not modify the Name, Firstname and Directory number columns which come from the internal 
directory record.   

For forwarding to voicemail, indicate the voicemail number. 
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3.6.10 TECHNICAL CHARACTERISTICS SECONDARY SUBSCRIBERS 

To be entered for a multi-line subscription. 

Main directory number: contains the directory number whose technical record has the Secondary 

directory number set to YES. 

3.6.11 SECONDARY UCP VOICE MAIL  

To be entered for a multi-line subscription. 

This line does not appear on the welcome page if the IVB option has been ticked. 

3.6.12 FORWARDS OF SECONDARY SUBSCRIBERS 

To be entered for a multi-line subscription. 

3.6.13 DIRECTORY RECORDS OF HUNT GROUPS  

Define the hunt group numbers 

3.6.14 TECHNICAL CHARACTERISTICS OF HUNT GROUPS 

For each hunt group number, define the directory numbers which must be attached to them.  

3.7 GENERATION OF IPBX DATA 

After all the information is entered in each of the tabs, click the Generate iPBX / MiVoice 5000 

Manager data button located at the bottom of the screen on the Home page to generate the data to be 
exported.  These data are grouped together in the following files: 

• An Install.conf file, containing the data meant for the CTRL I of a managed Mitel 5000 Gateways 
Series iPBX (example: 002.Mitel.install.conf). 

• A DataCollecting.zip file, containing the different .csv files from the collection and used by Web 
Admin (example: 002.Mitel.DataCollecting.zip). 

• MiVoice 5000 Manager_Form.xls (Excel 2003) file, to be imported into MiVoice 5000 Manager. It 
contains the data required to configure UCP and TWP accounts. 

• A file (Num_site.Nom_Site.amc.csv) to be imported into AMC. 

The generated files are placed in the same directory as the one in which the form is installed.   

Moreover, some traces files are generated but they are not used for the collection.  

3.8 COLLECTING DATA FOR A MULTI-SITE CONFIGURATION 

To create a multi-site configuration, the form will be used as many times as there are sites in the multi-
site configuration. It is advisable to create a directory per site with your customised form. 

The Choice on list Directory, Directory customization and External directory records links are not 

proposed for the 1st site of a multi-site configuration.  Now, the information contained in Choice on list 
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Directory and Directory customization is used in the options of the different tabs of other sites. 
Under these circumstances, the recommended procedure is as follows: 

1. For the first site of the multi-site network (by ticking Standalone site or first site of a multi-

site), fill out the tabs corresponding to the Choice on list Directory, Directory customization 
and External directory records links. 

2. Save the form and duplicate it in the directories created for the other sites.  

3. Return to the form of the first multi-site site and collect data from this site. 

4. Collect data from other sites by ticking the option Standalone site or first site of a multi-site).  

After checking the validity of the configuration, the administrator may generate the iPBX data for each 
of the multi-site sites.   
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4 IPBX PRE-REQUISITES 

Refer to the Document ANT/PTD/PBX/0151 

Data must be imported into Web Admin on a new installation, which will be restarted using one of the 
following modes: 

➢ By CTRL + I with the T (Total) option. 

➢ By CTRL + I with the U (USB key) option using a serial cable plug on the COM port. This mode is 
not supported by MiVoice 5000 Server : 

Dans ce cas, le fichier install.conf généré doit être copié sur la clé USB non protégée en écriture 
dans un répertoire spécifique, avec la syntaxe suivante du chemin d'accès : 

<USBKEYROOT>/aastraprovisionning/SiteNumber.Name.conf 

où <USBKEYROOT>/aastraprovisionning/ est le nom du répertoire et SiteNumber.Name.conf est 
le nom du fichier. 

Exemple : aastraprovisionning/020.Site1.conf 

 

Le fichier Install.conf est à nommer et copier sur la clé USB dans un répertoire à créer avec la 
désignation suivante aastraprovisionning. 

La syntaxe du nom de ce répertoire est à respecter impérativement. 

➢ Automatic start without Ctrl + i, taking into account the data collection file 

To start an Mitel 5000 Gateways system on a USB key without serial cable the generated 

install.conf file must be copied to a specific directory of a non write-protected key, which gives 
the following access path syntax: 

<USBKEYROOT>/aastra_usbconfig/install.<dongle_number>.conf 

where <USBKEYROOT>aastra_usbconfig/ is the directory name and 

install.<dongle_number>.conf the renamed file name, where <dongle_number> is the exact 
ID of the iPBX dongle. 

 

No subscriber should be configured on the iPBX (section 3.3.1). 

Therefore, since no subscriber has been created, create via Web Admin the IVB call number before 
importing data from the form. 

The abbreviated number length cannot be configured via the form. After the iPBX is restarted through 
CTRL I, the length is set to 3. If the length of the abbreviated numbers defined in the form is different 
from 3, it is necessary, before importing data from the form, to configure the iPBX with the right value 

(menu Telephony service > Subscribers > Rights > General parameters).  
An abbreviated number can only be assigned to a secondary subscription via Web Admin or MiVoice 
5000 Manager. 

It is necessary to check that the internal subscriber number length is correct (menu Telephony 

service> Numbering plan > User numbering plan > Access to extensions). 
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5 IMPORTING DATA INTO THE IPBX (STANDALONE 
SITE) 

Before importing the data, the administrator must back up the iPBX configuration so as to be able to 
restore it if some .csv files had been wrongly configured. 

Data is imported into the iPBX from the menus Telephony service, System > Software maintenance > 
Massive import: 

1. Select and download the Data.Collecting.zip file. 

2. Click Take account of the data. 

The duration of import depends on the amount of data to be downloaded.  Some counters are 
displayed to indicate the work progress status.   

• Example of counter 12/38: 15  

o 38: number of files to be imported 

o 12: number of files being imported 

o 15: line processed in the file being imported. 

An installation report is generated at the end of the import. 

5.1 INSTALLATION REPORT 

To generate and display the installation report, the browser used must authorise pop-ups for the site. 
The site must, therefore, be declared as a trusted site. 

5.1.1 DECLARING A TRUSTED SITE 

In Internet Explorer: from I.E. open the menu Tools > Internet options > Security tab. Tick Trusted 

sites then click Sites. Click Add opposite the site. 

In Fire-Fox: when the site tries to open a pop-up, Fire-Fox displays a warning bar. Click the 

Preferences button, proposed in order to authorise the action for this site.  
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5.1.2 SAVING THE REPORT ON THE PC 

When the end-of installation pop-up displays the report, the operations to perform in order to save this 
report differs according to the browser used.  

In Internet Explorer, proceed as follows: 

• Right-click and select Display source. 

• When the source file is displayed, open the File menu and select Save As... 

• Select All files and save in html format. 

 
CAUTION: In Windows 7, the editor does not allow the open file to be saved.  It is advisable 

to select all (CTRL + A) and copy/paste it in an editor such as Notepad. 

5.1.3 USING THE REPORT 

File names are listed on top of the html report, with links to the details.  

The values in red indicate errors; when you place the cursor over these fields a pop-up indicates the 
nature of the error. 

The digits in blue represent a link to the equivalent MMC in Web Admin: 
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6 CREATING A MULTI-SITE CONFIGURATION OR 
ADDING A NEW SITE 

This chapter describes how to use the data collection tool while creating a multi-site configuration. It 
equally applies to the creation of a new site in an existing multi-site configuration.   

On the iPBX side 

1. See Section 4 for site creation, and the multi-site manual AMT/PTD/PBX/0081 for the multi-site 
aspect. At this stage do not import data into the iPBX. 

2. Point each site of the multi-site configuration (or new site), to the centralising directory or to the 

MiVoice 5000 Manager directory: Telephony service > Subscribers > Directory> Parameters > 

Connections. 

3. Having previously collected data using the procedure described in Section 3.8, import data on a 

site-by-site basis from the corresponding .zip files (see section 5). Data import must start with 

the site defined as the first site of the multi-site configuration. 

On the MiVoice 5000 Manager side 

4. If the multi-site configuration is managed by a MiVoice 5000 Manager, generate data on the 

MiVoice 5000 Manager (see multi-site manual): Administration > Network topology > select the 

region or multi-site > Configuration > Generation. 

 
Note: to create a new site in an existing multi-site configuration, use the site import function in 

MiVoice 5000 Manager: Administration > Network topology > select the region and multi-

site configuration > select the site in the screen area Import a new site into the multisite 

then click Import. 

5. For each site, import the UCP and/or TWP records from the collection (Excel 2003 minimum must 
be installed on the client PC).   

o Go to the menu Telephony > Subscriber management >, Massive creation tab. 

o Select the site from the Export area. 

o In the External Server(s) area select UCP and/or TWP, depending on the data to be 

imported.  

o On the PC, select the file MiVoice 5000 Manager_Form.xls that corresponds to the site 

then click Import. 

o The massive processing operation is the same as the standard massive processing 

operation with MiVoice 5000 Manager. 
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